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Installing KNIME Analytics Platform


For step-by-step videos on how to install KNIME Analytics Platform, please take

a look at our KNIMETV YouTube channel.

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.
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Figure 1. KNIME Analytics Platform versions

4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

 Also check the KNIME Quickstart Guide and the KNIME Workbench Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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

On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

Extensions and integrations provide additional functionality for KNIME Analytics Platform.

They can be installed as follows.

Click File → Install KNIME Extensions…. A dialog opens and compiles a grouped list of

extensions to choose from.

The Install KNIME Extensions menu provides the extensions that are available via the update

sites you have enabled.

After selecting the extensions you want to install, click Next and follow the instructions;

KNIME Analytics Platform has to be restarted to apply the new extensions.


For more information, take a look at our video on How to Install Extensions in

KNIME Analytics Platform. Also see the Extensions and Integrations Guide.

KNIME Analytics Platform Installation Guide

© 2018 KNIME AG. All rights reserved. 4

https://youtu.be/8HMx3mjJXiw
https://youtu.be/8HMx3mjJXiw
https://docs.knime.com/2018-07/analytics_platform_extensions_and_integrations/index.pdf


Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

Do this by:

1. Clicking File → Update KNIME…. In the dialog that opens, select the available updates

you want to install and then click Next.

2. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, select File → Preferences →
Install/Update → Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 2. Available Update Sites

KNIME Analytics Platform 3.6 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

KNIME Community Contributions:

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Update Site: Provides

extensions created by KNIME partners.

Stable Community Contributions:

Provides additional extensions created by

the KNIME community.

KNIME Analytics Platform 3.6 Update Site and KNIME Community Contributions are enabled

by default.
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Adding External Update Sites

To install extensions that are not part of the above update sites, click Add (shown in Figure

Add Update Sites) to manually add the relevant update site, inserting the Name and Location

as shown below.

Figure 3. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If you receive an error message “Proxy Authentication Required” when connecting to a

remote update site (provided by a URL), or you do not have internet connection, you can

install extensions from a zip file. You can download KNIME update sites as zip files here.

• Save the zip file containing the extensions to your local system

• Open the Available Software Sites dialog and enter the path to the zip file by clicking

Add → Archive….


If the same extensions are provided by a URL, you will first have to disable the

update site by disabling it in the list.

• Now click Apply and Close
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Changelog (KNIME Analytics Platform 3.6)

Detailed changelog for v3.6.x releases

KNIME Analytics Platform 3.6.0

Release date: July 11, 2018

New Nodes

• AP-9873: Kafka Integration (Labs; several nodes to produce and consume messages

from Apache Kafka)

• AP-9869: Deep Learning Tensorflow Integration (nodes to read/write and run

TensorFlow deep learning models)

• AP-9867: Deep Learning Keras Integration (major enhancements and 50+ new nodes to

design deep learning networks)

• AP-9863: H2O Sparkling Water Integration (Run any H2O KNIME Workflow on Apache

Spark using "H2O Sparkling Water")

• AP-9862: New Database Integration (25+ node nodes; enhanced capabilities, e.g.

connection pooling, JDBC dialect support, feature richt SQL editor, rich type support,

etc.)

• AP-9472: Call Workflow (Table Based)

• AP-9292: Service Variable Input (a node to simplify assembling workflows that are

called by other workflows or via REST interface)

• AP-9104: Service Table Input (a node to simplify assembling workflows that are called

by other workflows or via REST interface)

• AP-8996: Constant Value Column Filter

• AP-8864: Numeric Outliers (Apply)

• AP-8745: Column Expressions (apply advanced expressions to modify or append a

number of columns)

• AP-8732: Git Client Integration (a number of nodes to read information from Git

repositories)

• AP-8676: Dictionary Tagger (Multi Column)

• AP-7707: Text Mining: New Stop Word Filter (revised)
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• AP-7247: Text Mining: Term Neighborhood Extractor

• AP-6411: Javascript Scorer Node

• AP-5355: Numeric Outliers

• BD-682: (Big Data Extensions): Spark Association Rule (Apply)

• BD-681: (Big Data Extensions): Spark Frequent Item Sets

• BD-596: (Big Data Extensions): Create Spark Context (Livy)

• BD-577: (Big Data Extensions): ORC File Writer

• BD-576: (Big Data Extensions): Parquet File Writer

• BD-572: (Big Data Extensions): ORC File Reader

• BD-571: (Big Data Extensions): Parquet File Reader

• BD-547: (Big Data Extensions): Spark Missing Value (Apply)

• BD-534: (Big Data Extensions): Spark Association Rule Learner

• BD-532: (Big Data Extensions): Spark Pivot

Enhancements

• AP-9219: Upgrade underlying Eclipse framework to version 4.7.3

• AP-9515: Text Mining: Update node description of POS Tagger and OpenNLP NE

Tagger

• AP-9510: Flow Variable of type date can’t be used as flow variable input

• AP-9496: Adding Padding Method to String Manipulation and Expression Engine

• AP-9480: Consistency of messages for temporary workflow copies opened in

workbench

• AP-9421: Update JSON Path library to 2.4.0

• AP-9420: KNIME SVG Support Extension as part of Standard Build

• AP-9251: Bundled Chromium for Mac and Linux

• AP-9223: KNIME protocol relative paths should work in when editing server workflows

• AP-9221: Workflow Difference to also inspect contents of Wrapped Metanodes

• AP-9193: Include global and user generated CSS in all JavaScript views

• AP-9139: H2O Integration: Improve node description for scorer and predictor nodes

• AP-9127: Node Generation: Implement prototype for new annotations
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• AP-9032: Excel style selection of multiple cells and copying their values in Table View

(JavaScript)

• AP-8989: Improved persistence of server mountpoints in Analytics Platform

• AP-8977: Speedup Logistic Regression Predictor, especially for 'wide' data/fingerprints

(tens of hundreds of attributes)

• AP-8976: DL Framework: Rename nodes

• AP-8965: R Integration: Improve detection of R Installation

• AP-8925: Update Infocom/ChemAxon extension to 3.6.0.v0901

• AP-8916: DL Framework: Make environment setup cancelable

• AP-8892: Recursive Loop End(s) with Option to choose FlowVariable in Dialog

• AP-8840: DL Framework: Integer collection to one-hot vector converter

• AP-8823: Amazon S3 nodes to support Server-Side Encryption

• AP-8748: Column-based storage: Support more than just native types

• AP-8744: Improve performance of DataCell#getType()

• AP-8731: DataTableDomainCreator: Improve performance

• AP-8723: Make Ungroup-node streamable

• AP-8704: New table storage format for KNIME tables based on Apache ORC (labs)

• AP-8683: Column Filter ("Twin List") with improved filter option

• AP-8636: (API) Credentials to be available during loadInternals()

• AP-8614: URI Ports selectable in Metanode’s Add Port dialog

• AP-8613: Support the extended character limit for Tweets

• AP-8598: Text Mining: Remove document cell type selection from preference page

• AP-8592: Placeholder if no results are found in node repository

• AP-8568: Switch from PhantomJS to headless Chromium for image generation in

JavaScript views

• AP-8555: Move individual views from context menu of wrapped metanodes into

submenu

• AP-8544: JavaScript Table Editor: support keyboard navigation

• AP-8543: JavaScript Table Editor: support pasting multiple values

• AP-8494: DL Framework: Auto-mapping of dimensions for multi-dim inputs

• AP-8451: Add better default color palette option to Color Manager node
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• AP-8447: File Upload supporting S3 buckets with permissions managed with IAM

policies

• AP-8432: Python Framework: Pure message driven communication

• AP-8360: Add in-memory credentials to Google Sheets Interactive Service Provider

• AP-8351: DL Framework: Keep column selection for networks with same input / outputs

• AP-8275: Dialog Component date to set time to 0 on empty all fields

• AP-8268: DeepLearning4J: Preference page options are not applied

• AP-8036: DL Framework: Support for not or partially defined input shapes

• AP-7884: H2O Integration: Inform user about column matching problems in H2O

Predictor nodes

• AP-7682: "FTP Connection" node with to support proxies

• AP-7560: Column-based storage: New Parquet table format

• AP-7558: (API) Extension point for table serializers (Parquet, ORC, Standard-KNIME)

• AP-7532: Replace variables in preferences files before application

• AP-7531: Write additional profile files to workspace directory

• AP-7530: Create plug-in customization file from preference profiles

• AP-7529: Add extension point for preference profile providers

• AP-7514: H2O Integration: Variable Importance Measurement Output DRF / GBM

• AP-7513: H2O Integration: Partitioner Options

• AP-7001: Java Snippet: New dialog tab to add installed bundles to code classpath

• AP-5673: Allow connecting and unconnecting nodes using keyboard shortcuts

• AP-5238: Node Replacement/Insertion to also work when moving nodes

• AP-5062: Better Zooming in workflow editor: as low as 25% zoom level and

ctrl+mousescroll to zoom in/out

• AP-3136: Update Apache Batik to 1.7

• BD-685: (Big Data Extensions): Add remote file handling input port to Create Spark

Context (Livy) node

• BD-666: (Big Data Extensions): Add Spark 2.3 to KNIME Extension for Apache Spark

• BD-659: (Big Data Extensions): Update hadoop-client library from 2.7.4 to 2.7.6

• BD-635: (Big Data Extensions): Reduce Spark Exception error messages length

• BD-629: (Big Data Extensions): Big data file format support for Spark to Hive (Impala)
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• BD-611: (Big Data Extensions): Use new Spark DataFrame API in preprocessing nodes

(partition, sampling, sort, rename column and join)

• BD-609: (Big Data Extensions): New seed parameter in Spark Collaborative Filtering

Learner node

• BD-507: (Big Data Extensions): New seed parameter in Spark k-Means node

• BD-450: (Big Data Extensions): Revise Spark PCA node

• BD-217: (Big Data Extensions): Add option to replace original columns to Spark

Transformations Applier

• BD-47: (Big Data Extensions): Improve append to existing Hive/Impala table with

Hive/Impala Loader

Bug Fixes

• AP-9672: Column/value selection quickforms broken in Firefox

• AP-9494: Table Writer has path from history set on create

• AP-9762: Table to H2O does not filter out String columns with only missing values

• AP-9735: Text Mining: Dictionary Tagger does not find repetitive patterns and does not

tag all entity occurences

• AP-9651: Writer nodes should handle cancellation gracefully

• AP-9647: Settings are not stored when restarting after prompt

• AP-9643: H2O Add Limit To Number of rows being cached.

• AP-9642: JavaScript scorer node: Non-informative error on numerical columns

• AP-9618: Learning monitor shows nothing when "log scale" is selected in Accuracy

mode

• AP-9598: Curved connection created between nodes outside the viewport doesn’t show

up (fully)

• AP-9594: DL Framework: Selection of inputs via Pattern doesn’t work

• AP-9593: Pie/Donut Chart not executed when frequency column value is 0

• AP-9588: Nullpointer in Value Selection Quickform

• AP-9585: File access problem while saving workflow

• AP-9556: Line Plot (JavaScript) fails to create SVG, if too many Y axis columns

• AP-9554: Problem opening two JavaScript-Views at the same time

• AP-9534: Possible message during update: "An exception occurred while executing a
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runnable."

• AP-9518: Determining MAC addresses on Ubuntu 18.04 fails due to missing ifconfig

command

• AP-9516: DL Keras: DLKerasTuple is not grayed out if optional

• AP-9497: DL TensorFlow Reader: possible race condition

• AP-9483: H2O Integration: Table to Frame casts to TypeCell instead of TypeValue

• AP-9481: Standard BIRT template out of date

• AP-9449: Tree Ensembles: Serialization bug for nominal columns with many possible

values

• AP-9447: H2O Integration: Random Forest Learner crashs unexpected for very small

data sets

• AP-9404: 'Download / Upload from List' fail to create parent folders

• AP-9397: H2O Integration: Target column present in column selection when dialog

opened

• AP-9374: Column Auto Type Cast fails if converted column is all missing values

• AP-9368: Deep Learning Learning Monitor view too large vertically

• AP-9356: Call Local Workflow occasionally does not update Path in configuration

dialog

• AP-9283: UI Width of element in Row Filter too small

• AP-9261: Zipped files in workflow will not exported when 'Reset workflow(s) before

export' enabled

• AP-9228: File chooser component does not reset after 'cancel' in dialog is clicked

• AP-9215: MacOS: Clear Console Crash

• AP-9212: Wrapped metanode templates don’t receive username when newly created.

• AP-9203: Null pointer exception in Random Forest

• AP-9201: Quick Node Insertion hotkey (ctrl-space) does not select text already present

in search box

• AP-9151: Null Pointer in Data Explorer

• AP-9119: R Integration: Errors during printing a value are not properly escaped

• AP-9118: Unzip Files: Null pointer exception when setting flow variable for output

directory

• AP-9111: DL Framework: Invalid converter when input changed
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• AP-9109: Filename persists in dialog despite user hitting cancel (Windows only)

• AP-9089: DL Framework: Investigate converter matching issues

• AP-9055: H2O Integration: Fix functionality of H2O Binomial Scorer

• AP-9053: Red X stays on node if node replacement is aborted with ESC

• AP-9052: Scatter Matrix node throws nullpointer for emtpy string column

• AP-9009: Java Snippet Dialog does not show missing jar files

• AP-8987: Workflow Coach locks KNIME when configured without Internet

• AP-8985: (Workflow) Annotation text possibly truncated when workflow zoomed >

150%

• AP-8724: Inconsistent Names of Prediction Columns in TreeEnsembleLearner (space

missing)

• AP-8685: Abnormal memory consumption in ExplorerFileStoreTransfer

• AP-8682: Improve NameFilter save/load filter configuration performance

• AP-8680: Table Creator: Inconsistent right-click behaviour on column header

• AP-8677: DL Framework: Dialog cannot be opened: failed to load config

• AP-8665: XML documents are not thread-safe

• AP-8607: Workspace Launcher is called Eclipse Launcher

• AP-8586: Workflow Coach Preferences can be set even if not enabled

• AP-8577: H2O Integration: Column Selection does not save Wildcard/RegEx and Type

Selection

• AP-8365: Workflow Coach View: Truncated text

• AP-8364: DataColumnSpecFilterPanel: Extremly slow for tables with many columns

• AP-8018: Dialog hot keys for Ok+execute is not reliably working

• AP-7835: DataColumnSpecFilterPanel: Changes of the input column type lead to

inclusion of filtered out columns when enforce inclusion is selected

• AP-6886: Parallel chunk loop fails if in wrapped meta node

• AP-6821: Width of UI element in POST Request node dialog overly large

• AP-6558: R nodes don’t provide full error message

• AP-6267: Unzip file node fails with NPE on invalid file

• AP-5670: Keyboard shortcuts not consistently working on MacOS

• AP-3134: SVG output in pie charts is broken when one Pie is >0.5
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• BD-714: (Big Data Extensions): Remove confirmation dialog in "Destroy Spark Context"

node

• BD-712: (Big Data Extensions): Spark Joiner fails if column names contains dots

• BD-699: (Big Data Extensions): Parquet to Spark does not allow to select file when

Source is invalid

• BD-697: (Big Data Extensions): Spark PCA node fails to refresh the target dimension

control after clicking the Flow Variables Tab

• BD-689: (Big Data Extensions): Spark Reader/Writer nodes do not support spaces in file

path

• BD-667: (Big Data Extensions): Spark "mean" missing value handler should change

column type to double

• BD-652: (Big Data Extensions): Spark Learner and Scorer nodes should handle booleans

• BD-642: (Big Data Extensions): Spark PCA/SVD/Correlation Matrix on Spark 2.x produce

different specs in KNIME and Spark

• BD-634: (Big Data Extensions): Mass column renaming on Spark 2.x takes too long

• BD-627: (Big Data Extensions): Spark Transformation Applier produces broken

DataFrame/RDD for type-changing transformations

• BD-612: (Big Data Extensions): Spark table spec contains possibly wrong metadata

• BD-393: (Big Data Extensions): Spark context state management prevents users from

reusing RDDs

KNIME Analytics Platform 3.6.1

Release date: Sep 3, 2018

Enhancements

• AP-10071: Expression Engine: Change Math Functions to use a JavaMethodProvider

• AP-9797: Call Workflow (Table Based) improve user error messages

• AP-9048: DB Connector node: Strip leading and trailing white spaces from jdbc url

Bug Fixes

• AP-10240: OSM Map View: MapQuest tiles broken
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• AP-10192: JS Table View: "Subscribe to filter" menu option has no effect

• AP-10039: Eclipse help doesn’t work any more due to wrong bundle resolution

• AP-10014: JSON to Table and JSON Path nodes throw errors when keys contain a

comma

• AP-9948: JavaScript bar chart NP when plot horizontal bars is selected with image

generation

• AP-9888: Iframe wrong resizing different quickform views to a minimum of 150px

• AP-9887: Label of range slider has now huge black font as a title

• AP-9885: JS Bar Chart losing interactivity on mouse-over when in wrapped metanode

view

• AP-9117: Fix OSM preference page

• AP-10294: Don’t show individual interactive views in context menu of a wrapped

metanode

• AP-10284: Opening exported workflow without data may cause NPE in JS views and

quickform nodes

• AP-10243: H2O Integration: Wrong node types/colors

• AP-10232: Java Snippet: Missing Converter Cache causes exception when creating file

store cells on output

• AP-10195: IllegalStateException during execution of Chunk Loop

• AP-10184: Missing Value node sometimes cannot be loaded

• AP-10145: H2O Integration: Predictor nodes report missing columns if column is of

wrong type

• AP-10135: Strip function description in String Manipulation and Column Expression

node

• AP-10127: DL Keras: Forbid to output the input-layer in executor

• AP-10117: Multiple dragged nodes delete single node

• AP-10115: Fix label position of 'load'-button in node monitor

• AP-10105: Selected back end 'Keras (TensorFlow)' is not available anymore

• AP-10103: Unhandled event loop exception when trying to insert a node between two

connected nodes inside a meta node

• AP-10084: The WebPortal/Wrapped Meta Node option gets checked every time

configuration of a JavaScript View node is changed

• AP-10081: Expression Engine: Strings get wrongfully recognized as identifiers
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• AP-10070: Expression Engine: Function average does not skip missing values and NaN

• AP-10061: DL Keras: Failing when keras runs in parallel

• AP-10060: DL Keras: Unconfigured keras network learner throws NullPointerException

• AP-10055: DL Keras: Network Reader loses executed state if file not available and not

copied

• AP-10048: PMML: Load (compiled) Model Content fails under Windows

• AP-10025: Document Vector Applier does not adjust columns order before creating a

collection cell

• AP-10016: Problem restoring mountpoint state

• AP-10010: DeepLearning4J: Better error message on OutOfMemory Error

• AP-9968: Call Workflow (Table Based) does not close called workflows on dispose

• AP-9966: Excel Reader Timeouts too small (causes some internal test cases to

sporadically fail)

• AP-9942: DL Keras: Custom loss fails for Model API

• AP-9933: Missing Value node slows down workflow load

• AP-9906: Call Workflow (Table Based) outputs non informative NPE error message

from Non-Native data value

• AP-9884: Expression Engine: Fix creation of LocalDateTime

• AP-9875: Wrapped Metanode Selection Interactivity lost after closing and re-opening

KNIME

• AP-9857: BarChart Tooltip display inconvenience

• AP-9843: DL Keras: Regularizers, Initializers, Constraints are not validated

• AP-9675: Call Workflow (Table Based) can not be configured when in temporary state

• AP-9476: HTTP/HTTPS Connection nodes ignore KNIME’s proxy settings (configured in

'Preferences')

• AP-9454: KNIME Protocol not properly resolved for Temp Workflows when workspace

contains space character

• AP-9439: Text Mining: French Stanford POS model uses another tag set than FTB

• AP-9410: Text Mining: StanfordNLP PTBTokenizer does not work in some cases

• AP-9149: Workflows fail when Python nodes run in parallel

• AP-8850: Bar Chart: shows last Missing Value Warning, even if those are resolved.

• AP-8829: JavaScript Bar Chart only shows one decimal digit in y-axis label
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• AP-8612: Python: Distinguish between SocketException causes during kernel startup

• AP-7306: JavaScript Bar Chart truncates labels

• AP-6424: Kruskal Wallis test - Contradiction between R and KNIME

• BD-775: (Big Data Extensions): Livy Job Controller changes order of files in Job with

Files Implementations

• BD-772: (Big Data Extensions): Create Local Big Data Environment fails when hostname

contains invalid characters

• BD-771: (Big Data Extensions): KNIME-on-Spark jar collection does not work in KNIME

3.6

• BD-726: (Big Data Extensions): Parquet writer node allows wrong input for filename

• BD-689: (Big Data Extensions): Spark Reader/Writer nodes do not support spaces in file

path

• BD-624: (Big Data Extensions): Create Local Big Data Environment: Create-Destroy-

Create fails when Hive data folder is set

• BD-607: (Big Data Extensions): Deactivating impersonation on KNIME Server with

Simba drivers results in "GSS initiate failed"

KNIME Analytics Platform 3.6.2

Release date: Nov 6, 2018

Enhancements

• AP-10242: Speed up execution of Bar Chart (JavaScript) and Pie/Donut Chart

(JavaScript)

Bug Fixes

• AP-10383: Context Menu dialog opens when applying changes in workflow annotations

on Mac OS

• AP-10377: Download/Upload from List fails when downloading files

• AP-10342: Bit vectors have the same icon as booleans

• AP-10580: Streamed Wrapped Metanodes can’t be properly canceled when in 'queued'

state (leaves workflow in inconsistent state)
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• AP-10574: Numeric Median Test: IndexOutOfBoundException

• AP-10540: JS Parallel coordinates plot should order categorical axes lexically

• AP-10496: H2O Integration: H2O MOJO Writer throws NPE when writing back to the

server

• AP-10484: DB locking might freeze KNIME server

• AP-10468: The output ports are swapped in H2O Cross Validation Loop Start node

• AP-10456: File Reader hangs when using Quick Scan for large files (no progress bar but

background proc ongoing)

• AP-10436: Call Remote Workflow node uses too low network timeout

• AP-10431: Column Type Auto Cast node: Inconsistent behavior for empty string

handling

• AP-10426: S3 Delete Files fails without checking the option to abort on fail

• AP-10382: Text Mining: DmlDocumentParser erase last parsed term due to a

referencing issue

• AP-10370: Text Mining: Document Data Assigner fails if file store chunk size is set to a

low value in preferences

• AP-10363: Window Loop Start fails when run concurrently

• AP-10341: Not supported style rules in SVGs might lead to null pointer exception in

Batik 1.7

• AP-10332: Bar Chart (JavaScript), new option to display maximum values

• AP-10295: Scorer Node Description: Link "accuracy statistics" is not correct

• AP-10263: Decision Tree Predictor fails if too many class values on append

probabilities.

• AP-10219: JavaScript scorer: disabling "Display confusion matrix totals as rates"

disables the totals completely

• AP-10216: Math Formula (Multi Column) fails on calculating statistics for non

"CURRENT_COLUMNS"

• AP-10197: 100 % accuracy in the view of the Scorer (JavaScript) node even though

some samples are not classified correctly

• AP-9811: Table Reader fails with "No entry data.bin in file" on non table files

• AP-9255: Wrapped Metanode - Node Usage Configuration Tab is missing Dialog Pane

• AP-7931: Python: Correct support for float32 in python bridge

• AP-7761: R_HOME value cause minor UI crash with invalid value
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• AP-6190: X-Partitioner is missing description for Linear Sampling
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